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License Agreement

(Single-User Products)
THIS IS A LEGAL AGREEMENT BETWEEN YOU, THE END USER, AND SEAGATE 
SOFTWARE, INC.  BY OPENING THIS SEALED DISK PACKAGE, YOU ARE 
AGREEING TO BE BOUND BY THE TERMS OF THIS AGREEMENT.  IF YOU DO 
NOT AGREE TO THE TERMS OF THIS AGREEMENT, PROMPTLY RETURN THE 
UNOPENED DISK PACKAGE AND THE ACCOMPANYING ITEMS (INCLUDING 
WRITTEN MATERIALS AND BINDERS OR OTHER CONTAINERS) TO THE PLACE 
YOU OBTAINED THEM FOR A FULL REFUND.

SEAGATE SOFTWARE LICENSE

1. GRANT OF LICENSE.   grants to you the right to use one copy of the enclosed Seagate 
software program (the "SOFTWARE") on a single terminal connected to a single computer (i.e., 
with a single CPU).  You may not network the SOFTWARE or otherwise use it on more than one 
computer or computer terminal at the same time.

2. COPYRIGHT.  The SOFTWARE is owned by Seagate or its suppliers and is protected by 
United States copyright laws and international treaty provisions.  Therefore, you must treat the 
SOFTWARE like any other copyrighted material (e.g., a book or musical recording) except that 
you may either (a) make one copy of the SOFTWARE solely for backup or archival purposes, or 
(b) transfer the SOFTWARE to a single hard disk provided you keep the original solely for 
backup or archival purposes.  You may not copy the written materials accompanying the 
SOFTWARE.

3. OTHER RESTRICTIONS.  You may not rent or lease the SOFTWARE, but you may 
transfer the  SOFTWARE and accompanying written materials on a permanent basis provided 
you retain no copies and the recipient agrees to the terms of this Agreement.  You may not reverse 
engineer, decompile or disassemble the SOFTWARE.  If SOFTWARE is an update, any transfer 
must include the update and all prior versions.

4. DUAL MEDIA SOFTWARE.  If the SOFTWARE package contains both 3.5" and 5.25" 
disks, then you may use only the disks appropriate for your single-user computer.  You may not 
use the other disks on another computer or loan, rent, lease, or transfer them to another user 
except as part of the permanent transfer (as provided above) of all SOFTWARE and written 
materials.

LIMITED WARRANTY

LIMITED WARRANTY.  Seagate warrants that the SOFTWARE will perform substantially in 
accordance with the accompanying written materials for a period of 90 days from the receipt.  
Any implied warranties on the SOFTWARE  are limited to 90 days.  Some states do not allow 
limitations on duration of an implied warranty, so the above limitation may not apply to you.

CUSTOMER REMEDIES.  Seagate's entire liability and your exclusive remedy shall be, at 
Seagate's option either (a) return of the price paid or (b) repair or replacement of the SOFTWARE 
that does not meet Seagate's Limited Warranty and which is returned to Seagate with a copy of 
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your receipt.  This Limited Warranty is void if failure of the SOFTWARE has resulted from 
accident, abuse, or misapplication.  Any replacement SOFTWARE will be warranted for the 
remainder of the original warranty period or 30 days, whichever is longer.  THESE REMEDIES 
ARE NOT AVAILABLE OUTSIDE OF THE UNITED STATES OF AMERICA.

NO OTHER WARRANTIES.  Seagate disclaims all other warranties, either  express or implied, 
including but not limited to implied warranties of merchantability and fitness for a particular 
purpose, with respect to the SOFTWARE and the accompanying written materials.  This limited 
warranty gives you specific rights.  You may have others, which vary from state to state.

NO LIABILITIES FOR CONSEQUENTIAL DAMAGES.  In no event shall Seagate or its 
suppliers be liable for any damages whatsoever (including, without limitation, damages for loss of 
business profits, business interruption, loss of business information, or other pecuniary loss) 
arising out of the use of or inability to use this Seagate product, even if Seagate has been advised 
of the possibility of such damages.  Because some states do not allow the exclusion or limitation 
of liability for consequential or incidental damages, the above limitation may not apply to you.

U.S. GOVERNMENT RESTRICTED RIGHTS

The SOFTWARE and documentation are provided with RESTRICTED RIGHTS.  Use, 
duplication, or disclosure by the Government is subject to restrictions as set forth in subparagraph 
(c)(1)(ii) of The Rights in Technical Data and Computer Software clause at 52.227-7013.  
Contractor/manufacturer is Seagate Software, Inc., 708 Fiero Lane, Suite 5, San Luis Obispo, CA  
93401.

This agreement is governed by the laws of the State of California.

Should you have any questions concerning this agreement, or if you wish to contact Seagate for 
any reason, please write Seagate Software, Inc., 708 Fiero Lane, Suite 5, San Luis Obispo, CA  
93401.
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Getting Started
Backup Exec is a powerful backup solution for Windows 95 designed to pro-
tect your valuable data. This user manual provides detailed information and 
procedures for installing, using, and navigating within Backup Exec. Other 
valuable information is available through Backup Exec's On-line Help.

Where to Look—Getting Started

For information about See

Installing and configuring 
Backup Exec

Installing Backup Exec, page 10

Using Automatic Data 
Protection

Automatic Data Protection, page 14

Backing up and restoring your 
files quickly

One-Button Backup, page 14 
One-Button Restore, page 15

Creating an Emergency Restore 
Disk

Creating an Emergency Recovery 
Diskette, page 43

Using Emergency Restore Emergency Restore, page 44

Restoring all your files without 
an emergency restore disk

Restoring All Your Files, page 46

Using Backup Exec’s Wizards to 
create backup and restore jobs

Using the Backup Wizard, page 
26 and Using the Restore Wizard, 
page 48

The Backup window and options Where to Look—Backup, page 23

The Restore window and options Where to Look—Restore, page 43

The Compare window and 
options

Where to Look—Compare, page 57
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Installing Backup Exec
This section provides system requirements and installation instructions.

System Requirements
Make sure your computer meets the following requirements before you begin 
the installation.

• IBM or 100% compatible 386/DX or higher

• 8 MB RAM or greater

• Windows 95

• A hard drive with at least 10MB free

• A Microsoft or 100%-compatible mouse is highly recommended

Installing Your Software
To install Backup Exec

1 Select Run from the Start menu.

2. Type (Your CD-ROM drive letter):\SETUP.EXE and press Enter. The CD 
Browser appears. The Browser allows you to choose from available 
products and languages.

3. Select your language and product, then click Install.

Configuring Your Backup Device
Most types of backup devices are automatically detected and configured the 
first time you run Backup Exec. Your backup device will be listed in the 

Designing and implementing an 
effective backup strategy

Backup Strategies, page 67

Solving common problems Troubleshooting Tips, page 73 

Getting technical assistance Technical Support, page 83

For information about See
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Where to back up box and in the lower right corner of the Backup Exec win-
dow.

NOTE: If your backup device is not detected and you are not using a 
high-speed controller card, see “Backup Device Configuration” on 
page 73 for troubleshooting information.

Adding a High-Speed Controller Card or an IDE Controller Card
If you want to install a high-speed controller card, use the Windows 95 Add 
New Hardware Wizard after you’ve finished installing Backup Exec. If you 
want to change settings for a hardware device, use the Windows 95 System 
Device Manager window. 

To install a High-Speed Controller Card or an IDE Controller Card:

1. Choose settings from the Start menu, then click Control Panel.

2. Double-click the Add New Hardware icon.

The Add New Hardware Wizard appears.

3. To begin installing your card, click Next.

4. The Add New Hardware Wizard asks you if you want Windows to 
search for your new hardware. Click No, then click Next to continue.

5. Select Tape drive controllers from the Hardware types list. Click Next 
to continue.

6. Choose the manufacturer and model of your card. Click Next to 
continue.

7. Windows 95 displays the Resource Type and Settings. Print or write down 
these settings, which you will use to configure your card. See “To change 
your hardware settings:” below, to adjust these settings. Click Next to 
continue.

NOTE: If Windows 95 cannot find suitable settings, click Next, then click 
Start Conflict Trouble Shooter and follow the instructions. 

Or, 

Click Cancel. If you cancel, your hardware is not added and you are 
returned to the My Computer window. See Windows Help or your 
Windows 95 User’s Guide for more information on resolving hardware 
conflicts.

8. Click Finish.
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9. Shut down your computer.

10. Change the settings on your card to match the settings provided by the 
Windows 95 Add New Hardware Wizard.

See your hardware manual for information on changing your card’s 
settings.

11. Restart your computer and Windows 95.

To change your hardware settings:

1. Choose settings from the Start menu, then click Control Panel.

2. Double-click the System icon.

3. Click the Device Manager tab in the System Properties window.

The Device Manager tab appears.

4. Select the hardware that you want to change settings for, then click 
Properties.

The Properties window appears.

5. Click the Resources tab in the Properties window.

6. To change your Input/Output Range, Interrupt Request, or Direct Memory 
Access settings, highlight the item and click Change Setting. Make any 
changes and click OK.

7. Close the System control panel.

8. Shut down your computer.

9. If necessary, change the settings on your card and reinstall it in your 
system. See your hardware manual for instructions.

10. Restart your computer and Windows 95.

NetWare Support
NetWare support provided by Backup Exec includes the capability to back up 
the NetWare 3.11-3.12 server bindery, and NetWare file and directory 
attributes from NetWare server volumes, including trustee information. Use 
the Back up Netware Bindery... option to back up your Netware bindery files. 
See  ”Advanced Tab” on page 40 for more information on this option.
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All NetWare file attributes and trustee information is backed up, except MAC 
name space. When these files are restored to a NetWare volume, the extended 
information also restores. If the trustee information is not applicable to the 
restore location, it will not restore. An error message is posted to the log file if 
this occurs.

A network administrator on a NetWare 3.11-3.12 server can back up and 
restore the server bindery. The bindery is automatically selected for backup if 
any file from the SYS volume is selected and the bindery option in the Options 
dialog is also selected. Restore works similarly. If the Restore Bindery option 
is selected in the Options dialog, and any file on the SYS volume is selected for 
restore, you are promted to restore the bindery.

NOTE: For trustees, EAs, and bindery backup or restore the user must be 
logged into the server as a network administrator and the Novell 32-bit 
NetWare client must be installed.

Although NetWare Directory Services may appear in the selection panes, 
please be aware that their folder structures cannot be backed up or restored.

Starting Backup Exec
When you install Backup Exec, the program and its folder are added to the 
Windows 95 Start menu. If you chose to have a Backup Exec icon added to 
your desktop, you may double-click this icon to open the program.

To start your backup software:

1. Click the Start button on the Windows 95 taskbar.

2. Select Programs and point to the Backup Exec folder.

3. Click Backup Exec.

4. Backup Exec opens and also appears on the taskbar. 

5. The Backup Exec Startup window displays.

Quick Start
This section shows how to back up and restore your files easily and quickly 
using Automatic Data Protection, One-Button Backup, and One-Button 
Restore. Before you start, be sure your backup devices have been detected and 
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configured by Windows 95. See  ”Configuring Your Backup Device” on page 
10.

Automatic Data Protection
Automatic Data Protection ensures your data is backed up on a regular basis. 
When you first start the application, you are prompted with the option of initi-
ating Automatic Data Protection. 

Any job created with Automatic Data Protection can later be edited with 
Backup Exec. You can also use System Agent to schedule a job created with 
Automatic Data Protection.

To use Automatic Data Protection:

1. Select a day of the week for the backup job to run, or select “Daily” or 
“Weekdays”. 

If you choose a day of the week the “New and changed files” option is 
displayed. If you choose “Day” or “Weekday”, the “New and changed 
files” option is not displayed and All Selected Files backups are 
automatically performed.

2. Click OK.

One-Button Backup
One-Button Backup launches a backup of all local hard disks, including the 
Registry.

To use One-Button Backup:

1. Double-click the One-Button Backup icon in the Backup Exec program 
group. Or, click the Start menu, select Programs, select Backup Exec, and 
then click One-Button Backup. 



The One-Button Backup 
dialog appears.

2. Select a device or Files or 
Folders in the drop-down list 
box. If you select Files or 
Folders, a text box and 
browse button appear. See 
“Files or Folders Backup” on 
page 30 for more information.

3. Click Start.

The backup will run as either a full or differential backup (with default 
settings) depending on the following criteria. For more information on full 
and differential backup types, see Backup Types, page 70

An All Selected Files backup is performed if:

• Ten differential backups have been performed since the last All Selected 
Files backup, regardless of dates.

• More than seven days have passed since the last backup.

A differential backup is performed if:

• No more than seven days have passed since the last All Selected Files 
backup.

Default Backup Job Settings
Your backup job will run with the following default settings:

• What to back up—All Selected Files. See “What to Back Up” on 
page 30.

• Where to back up—Tape Drive. See “Where to Back Up” on page 30.

• How to back up—Compress, Prompt. See “How to Back Up” on page 31.

One-Button Restore
One-Button Restore launches a series of dialogs which help you perform a 
restore in just a few steps.
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To run One-Button Restore:

1. Double-click the One-Button Restore icon in the Backup Exec program 
group. Or click the Start menu, select Programs, then select Backup Exec, 
and then click One-Button Restore. 

The One-Button Restore 
dialog box appears.

2. Select a device or Files or 
Folders in the drop-down list 
box. If you select Files or 
Folders, a text box and 
browse button appear. See 
“Files or Folders Backup” on 
page 30 for more 
information. Click Next to 
continue.

3. Check the drives, folders, 
and files you want to restore.

4. Click Start to begin restoring 
your files. A message 
appears when the restore 
completes.

Restore Default Settings
Your restore will run with the following default settings:

• What to Restore—Folder view. See “File Views” on page 52.

• Where to restore—Original Location. See “Where to Restore” on 
page 53.

• How to restore—Do not replace. See “How to Restore” on page 54.
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Using Backup Exec
This section provides an overview of the various tools and features that 
Backup Exec offers.

Menus
The title bar contains five menu items: Job, Edit, 
View, Tools, and Help.You can access these menus 
and the submenu items at any time.

The Backup, Restore, and Compare tabs appear at 
the top of the main application window. Click these tabs 
to move between program functions. 

Toolbar
Use Backup Exec’s toolbar to select program features with a single mouse 
click. Hold the cursor over a button for a short description of its function.

Toolbar buttons (listed from left to right) perform the following functions:

Click: To do this:

Create a new untitled backup job.

Open a saved backup job.

Name and save a backup job for future use.

Select one or more highlighted drives, folders, or files, and 
place check marks next to them.

Deselect one or more highlighted drives, folders, or files, and 
remove the check marks next to them.
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Open the Restore File Version dialog box to choose the 
specific version of a file you want restored.

Open the Backup Wizard, which leads you step-by-step 
through the selection of files, settings, and options for your 
backup.

Open the Restore Wizard, which leads you step-by-step 
through the selection of files, settings, and options for your 
restore.

Open the Job Options dialog box, where you can select options 
for the current backup job.

Display your files as small icons in vertical rows (List View).

Display your files in a vertical list with file size, type, and 
modified date (Detail View).

Display a short description of menu items, windows, buttons, 
and boxes when the item is clicked.

Click: To do this:
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Selection Panes
Drives and files are selected the same way in Backup Exec as they are in Win-
dows Explorer. Selection panes are used to select and deselect drives, folders, 
and files for backup, restore, and compare.

The two sections of the selection panes are:

• All Folders Pane—On the 
left. Displays a list of your 
computer’s drives and 
folders. 

• Contents Pane—On the 
right. When a folder is 
highlighted in the All 
Folders Pane, the files in 
that folder appear in the 
Contents Pane. 

Click the Expand/Collapse but-
ton to expand or collapse a 
folder.

• A plus sign (+) means the 
listing can be expanded to 
display additional folders.

• A minus sign (–) means the 
listing can be collapsed so 
that folders beneath it are 
not displayed.

• Folders without buttons 
indicate there are no subfolders.

Click a selection check box to select or deselect files and folders. 

• An empty check box means the drive, folder, or file has not been selected 
for backup or restore.

• A blue checkmark means one or more items in a folder have been selected 
for backup or restore.

• A gray checkmark means that some, but not all, of a drive or folder has 
been selected.

All Folders Pane

Contents Pane

Expand/collapse button

Selection check box
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• A red X means that the file’s type has been excluded. See “Exclude Files 
Tab” on page 39 for more information.

Help
The Backup Exec on-line help system provides in-depth information about the 
program and its functions.

Context-Sensitive Help
Context-sensitive help provides you with information about the current win-
dow, dialog box, or program message. To get context-sensitive help on the cur-
rent operation, press the F1 key on your keyboard.

Help Menu
The Help menu provides help for each program function and assistance with 
backup and restore concepts and skills. There are three items in the Help menu: 
Help Topics, Using Help, and About Backup Exec.

Help Topics

Help Topics opens the Help win-
dow, which contains three tabs.

• The Contents tab displays a list 
of topics in the help system 
arranged by category.
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• The Index tab lists keywords 
alphabetically. Type the first 
few letters of a keyword and 
matching items are 
highlighted.

• The Find tab provides a full-
text search capability for any word or 
phrase in help. You must set up the 
search file the first time you use the 
Find tab. Then type a word or phrase 
and select a topic from the list. 

Using Help

The Using Help menu item provides help 
for the help system. It explains how to use 
help effectively and how to customize your 
help system.

A book represents a help category containing subtopics. 
Double-click the book to open it.

An open book displays a list of topics and books.

A page represents a help topic. Double-click it to open the help 
window for that topic.
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About Backup Exec

About Backup Exec displays your software’s version number and licensing 
information.

Exiting Backup Exec
• On the Job Menu, click Exit.

Or,

• Click the Close button.

You are asked if you want to save any changes to your current backup job. 
Click Yes to save your backup job or click No to discard the changes. The 
application closes.



Using Backup Exec

Using Backup Exec 23

Using Backup
This chapter explains how to use the Backup window to copy files from your 
computer to a backup location. It begins by describing the steps needed to per-
form a backup using Backup Exec. 

Your first backup should be of your entire computer. After you have backed up 
your computer, you can create backup jobs to save your options and file 
selections. By creating several jobs, you can customize your backups and 
protect your data quickly and, if you wish, automatically. 

You can use a Backup Wizard or the Backup window to create a backup job. 
Selections and options are described in later sections of this chapter.

Where to Look—Backup
For more help about backup topics, see: 

• One-Button Backup, page 24

• Backup Jobs, page 25

• Using the Backup Wizard, page 26

• The Backup Window, page 29

• Backing Up Files with the Backup Window, page 31

• Using Backup Jobs, page 33

• The Backup Set, page 35

• Backup Options, page 35

• Advanced Tab, page 40
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One-Button Backup
One-Button Backup launches a backup of all local hard disks, including the 
Registry.

To use One-Button Backup:

1. Double-click the One-Button Backup icon in the Backup Exec program 
group. Or click the Start menu, select Programs, select Backup Exec, and 
then click One-Button Backup. 

The One-Button Backup 
dialog appears.

2. Select a device or Files or 
Folders in the drop-down list 
box. If you select Files or 
Folders, a text box and 
browse button appear. See 
“Files or Folders Backup” on 
page 30 for more information.

3. Click Start.

The backup will run as either a full or differential backup (with default set-
tings) depending on the following criteria.

An All Selected Files backup is performed if:

• Ten differential backups have been performed since the last All Selected 
Files backup, regardless of dates.

• More than seven days have passed since the last backup.

A differential backup is performed if:

• No more than seven days have passed since the last All Selected Files 
backup.

Default Backup Job Settings
Your backup job will run with the following default settings:

• What to back up—All Selected Files. See “What to Back Up” on 
page 30.

• Where to back up—Tape Drive. See “Where to Back Up” on page 30.
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• How to back up—Compress, Prompt. See “How to Back Up” on page 31.

Backup Jobs
Backup Exec uses backup jobs to save and reuse file and option selections. 
You create a backup job by selecting drives and files for backup, choosing pro-
gram settings and options, and saving your selections with a new job name.

A backup job includes all selections made at the time it is saved:

• Drives, folders, and files to back up

• Backup type

• Backup device

• Options selected or default selections

Backup jobs can be opened, saved, and deleted using the Job menu. In the 
Backup window, you can open a backup job with the Backup Job list.

To change a backup job, simply make new file or option selections. When you 
run a backup, your changes are automatically saved. To save your changes 
under a different name, choose Save As from the Job menu and enter a new 
name, or type the new name in the Backup Job list box. If you attempt to save a 
new job using an existing name, the program asks you whether or not to over-
write the existing job. If you choose overwrite, the new job replaces the exist-
ing job. 

You can use the Backup Wizard (page 26) or the Backup window (page 31) to 
create new backup jobs or you can modify and rename existing job files.

By saving your backup jobs, you can run 
them again without making your selections 
again. 

The Backup Job box lists your saved 
backup jobs. Type a new name in the box to 
save the job under a different name.

NOTE: You must make file selections 
before saving your backup job.
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Using the Backup Wizard
The Backup Wizard is a series of dialog boxes that guides you through the 
steps required to create a new backup job. 

The Backup Wizard is used to create new backup jobs. It cannot be used to 
modify an existing job.

Using the Wizard is easy. All you need to do is make selections by clicking the 
appropriate options. After you’ve made your selections, click the Next button 
and the Wizard displays the next step. 

To create a job using the Backup Wizard:

1. Click Backup Wizard in the Startup window, then click OK. 

Or,

Click the Backup Wizard icon on the toolbar.

The What to Back Up 
window of the Backup 
Wizard is displayed.

2. Select the drives and files you 
want to back up.

To back up all files, folders, 
and drives on your computer, 
click Back up all files on my 
local drive(s). Click Next to 
continue. The Backup Type 
Wizard window appears.

Or,

To back up only some of the files, folders, or drives on your computer, 
click Back up only certain files, folders, or drives. 
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The Backup Wizard Selection 
Panes appear.

Select the specific drives, 
folders, and files you want to 
back up. For more 
information on selecting 
files, see page 19. Click Next 
to continue.

3. Select a backup type.

Click All Selected Files to 
back up all selected files, then 
click Next. 

Or,

Click New and Changed Files 
Only to back up only files that 
are new or have changed 
since the last All Selected 
Files backup and click Next.

TIP: New and Changed Files Only will use a differential backup type. For 
more information on backup types, see page 70. 

4. Select a destination for the 
backup from the Where to 
back up list. You may choose 
a backup device, or Files or 
Folders. See ”Files or Folders 
Backup” on page 30 for more 
information. 

Click Next to continue.
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5. The How to Back Up Wizard 
window appears. Click 
options to select or deselect 
them. For information about 
backup options, see page 31.

Click Next to continue.

The When to Back Up Wizard 
window appears. 

6. Click Now to begin this 
backup immediately or click 
Later to schedule this backup 
for a later time.

To back up later, specify the 
frequency, then set the time, 
date, and/or days of the week 
to run this backup job. For 
more information on 
scheduling your backup job, see page 40. Click Next to continue.
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The Name the Backup Job 
window appears.

7. Type a name for this backup 
job.

8. Review the backup job’s 
summary. To change an 
option, use the Back and Next 
buttons. 

9. Click Start to begin this 
backup job. The Backup 
Progress window appears. 

Or, Click Finish to run your job as scheduled.

The Backup Window
This section first describes the Backup window. Step-by-step instructions for 
creating backup jobs begin on page 31.

The Backup window gives you quick access to all the backup job options, and 
includes four main sections.

• Backup Job—Select your 
Backup Job from the drop-
down list.

• What to Back Up—Select 
your drives and files to 
back up from the selection 
pane. Choose the backup 
type.

• Where to Back Up—
Select a device, or select 
Files or Folders to back up 
your files to your hard 
drive, a network drive, or a 
floppy disk.

• How to Back Up—Lists your option settings, and displays the Options 
button.
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Backup Jobs List
The Backup Job list box contains all available backup jobs. If you are creating 
a new backup job, Untitled appears as the default name. To save a new backup 
job, click Save from the Job menu.

What to Back Up 
Select your backup type and files in the What to back up section.

Two backup types are displayed in the Backup window under What to back up: 
All Selected Files, and New and Changed Files. 

• All Selected Files—Backs up all selected files.

• New and Changed Files—Backs up all the selected files that have 
changed since the last All Selected Files backup.

If you choose New and Changed Files, the default setting is differential 
backup. Use the Option button to change your backup type. See “Type Tab” on 
page 38 for more information or “Backup Types” on page 70 for a complete 
description of each type.

Backup Selection Panes
Backup Exec uses the same drive and file selection methods as the Windows 
95 Explorer. Drives and folders are selected in the All Folders Pane and indi-
vidual files and folders are selected in the Contents Pane. Select drives and 
files to back up by clicking the check box next to the item. For more informa-
tion, see “Selection Panes” on page 19.

Where to Back Up
The drop-down list box in the “Where to back up” section contains the names 
of all your backup devices. Your primary backup device is automatically 
selected for your backup device. To change your backup location, select 
another device in the drop-down list box, or select Files or Folders to back up 
your files to your hard drive, a network drive, or a floppy disk.

Files or Folders Backup

The Files or Folders option enables you to back up your 
files to a custom location, such as a hard disk, a network 
drive, or a floppy disk. 
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When files are backed up to Files or Folders, Backup Exec uses a special nam-
ing convention to help organize these items. Files or Folders appear with a 
.MTF extension. If you open a Files or Folders item in Explorer, Backup Exec 
automatically launches.

You cannot use the Files or Folders option for Emergency Restore.

NOTE: The Files or Folders option does not require that your files are 
written to a media that’s formatted for back up use only. You may want to 
use the Files or Folders option if you plan on using a media for additional 
purposes other than back up. However, if you use a media that is formatted 
for back up use only, you may only write backup files to that device.

To back up to Files or Folders:

1. Select Files or Folders in the drop-down list box in the Backup window.

A text box and browse button appear below the drop-down list box. 

2. Type a path in the text box.

Or,

Click Browse, select a folder in the list, then click OK. The folder appears 
in the text box.

NOTE: You may also specify a filename for your Files or Folders 
Backup. However, if you do not type a filename, Backup Exec provides a 
name for you.

How to Back Up
The Backup Job Options dialog box lets you set your backup options, 
password protect your backup set, and change your backup type. Current 
option settings are listed above the Options button. For information about 
backup options, see “Backup Options” on page 35.

Backing Up Files with the Backup Window
To back your files up using the Backup window:

1. Select New from the Job menu. 

The Backup window appears.
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2. Select What to back up. All 
selected files is the default 
setting. To change your 
backup type, click New and 
changed files.

See “Type Tab” on page 38 
for more information.

3. Select the files to back up. Click the check boxes next to the drives and 
files you want to back up.

A blue checkmark indicates the drive, file, or folder is selected for backup. 
A red X indicates that the file’s type is excluded.

See “Selection Panes” on page 19 for more information.

4. Select Where to back up. To change your backup 
destination, select another device from the list, or 
select Files or Folders to back up your files to your 
hard drive, a network drive, or a floppy disk. 

See “Where to Back Up” on page 30 for information on the Files or 
Folders option.

5. Select How to back up. The default settings are Full 
Compression and Prompt. To change your backup 
options, click Options. The Backup Options dialog 
box lets you set each of your options. See “How to 
Back Up” on page 31.

6. Click Schedule to run your 
job at a later time. See 
“Advanced Tab” on 
page 40.

Or,

Click Start to run your backup job now. Your backup job is saved. See 
“Backup Progress Window” on page 34.

Or,

Select Save from the Job menu to save your job for future use. The name 
you give it will appear in the Backup Job list.
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Using Backup Jobs
To open a backup job:

1. Click the Backup tab in the main application window.

2. Highlight a job name in the 
Backup Job combo box.

The backup job’s settings 
appear.

Or,

Choose Open from the Job menu. 

The Open Backup Job dialog box 
appears.

3. Select a Backup Job from the list. 

Or, 

Type a job name (description) in the 
Job to open text box.

4. Click Open.

To change settings in an existing backup job:

1. Open the backup job you want to modify and make your changes.

2. Choose Save As from the Job Menu.

The Save Backup Job As dialog box 
appears. It is identical to the Open 
Job dialog box.

3. Type a name into the Job Name text 
box. You may type a name of up to 
130 characters (including spaces).

4. Click Save.

To delete a backup job:

NOTE: You cannot delete the job that is currently open. To delete the 
current job, open a different job, then proceed.
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1. Choose Delete from the Job menu.

The Delete Backup Job dialog box 
appears. It is identical to the Open 
Job dialog box.

2. Select a Backup Job, or type a job 
name (description) in the Job Name 
text box.

3. Click Delete. You are asked to 
confirm your action. Click Yes to continue.

To run your backup job:

• Click Start. 

If your backup job is new or modified, the program prompts you to save 
the backup. The new job is added to the Backup Job combo box when it is 
saved.

Backup Progress Window
The Backup Progress window appears 
when you start your backup. It continually 
updates information about your backup job. 

The name of the backup job in progress is 
displayed in the window title bar.

The top section displays the backup device, 
media name, and the current status of the 
backup job. 

The center section displays a progress bar 
showing the percentage of the backup job 
completed and the estimated time remain-
ing.

The bottom section displays the name of the file currently being processed, the 
estimated number and size of files to be backed up and already processed, and 
the compression ratio. 

When the backup is complete, the OK and Report button replace the Cancel 
button. Click Report for a summary of your backup or click OK to continue.
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Canceling Your Backup
You can cancel the backup at any time by clicking Cancel or pressing Esc. 

NOTE: Canceling your backup may take several minutes, depending on 
the size of the backup set.

CAUTION:  If you cancel a backup, some backup devices will not be able to 
recover the space already used by the backup on the media. To use this space, 
you will have to erase or overwrite the entire media.

Viewing Your Backup Report
When the backup is complete, the Cancel button changes to OK and a Report 
button is displayed below it. Click Report to view a summary of your backup 
or click OK to continue.

The Backup Set
After you perform a backup job, your files are stored on the media in a special 
format called a backup set. If your backup uses two or more medium, one 
backup set is stored on each media. Information about each backup set is stored 
in the catalog. For information about catalogs, see “Catalog Cleanup” on 
page 65.

Backup Options
To open the Backup Job Options dialog box:

• Click Options in the How to backup section.

The Backup Job Options dialog box appears.

Backup Job Options Dialog Box
The Backup Job Options dialog box contains the following tabs:

• General Tab (page 36).

• Passwords Tab (page 37).

• Type Tab (page 38).

• Exclude Files Tab (page 39).

To display an option group:

• Click on a tab.



The option group appears.

To select an option or change an option setting:

• Click on the check box or button next to the option.

To save your current settings and change option groups:

1. Click Apply.

2. Click the next option group’s tab. 

To save your option settings and return to the Backup window:

• Click OK.

Your backup options are saved and you return to the Backup window.

General Tab
Use the General tab to set the Verify data 
and Compression options and tell Backup 
Exec how to handle medium that already 
contain backups.

• Verify data by performing a file-by-
file compare after the backup has been 
completed.

If you back up with the Verify Data 
option on, Backup Exec will verify the 
data by reading it back from the 
backup medium after writing it and 
comparing it to data on the disk. 
Because Verify Data takes twice as 
long, you may choose to turn this option off. However, it is strongly 
recommended that you use Verify Data to help ensure the reliability of 
your backups.

• When backing up to media

Never compress the data—turns data compression off.

Compress data and save time during backup—compresses your data as 
much as possible with a minimum reduction in speed.

Maximize compression and save space on media—compresses your 
data as much as possible without regard to speed. This may cause your 
backup to take longer, however the resulting backup set will use less 
space.
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Compression uses a “shorthand” to reduce file sizes, so that data can be 
written in less space.

NOTE: If your data has already been compressed, select Never compress 
the data. Compressing data that has already been compressed, causes the 
data to occupy more media space..

• If the media already contains backups

Append this backup to my media—your data is placed after the last 
backup set on the media.

Overwrite the media with this backup—all the backup sets on your 
media are overwritten.

CAUTION:  If you choose to overwrite the media, all data on the media will 
be erased.

Let me choose this option during the backup—the name of the media in 
the drive is displayed when the backup job begins, and you are prompted 
to choose Overwrite or Append.

If the tape is blank use this tape name—you can name the tape if it is 
blank by typing a tape name in the text box.

Passwords Tab
Use the Passwords tab to provide data security by password-protecting your 
backup. Your password is required to load or retrieve a catalog, and compare 
or restore files in the backup set.

CAUTION:  Make careful note of your password. Without it, you will not be 
able to access or recover data in your password-protected backup set. 
Passwords are case-sensitive. For example, “my password” is not the same as 
“My Password.” 
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To create a password:

1. Click Password protect backup set. 

2. Type your password in the Password 
text box.

3. Retype your password in the Confirm 
password text box.

4. Click OK. 

Type Tab
Use the Type tab to choose a backup type 
and to select Unattended operation.

Backup types

• All selected files—Backs up all the files 
you have selected.

• New and changed files only—If you 
choose New and changed files, two 
additional backup types are displayed.

Differential backup type—Backs up all 
the selected files that have changed 
since the last All Selected Files backup.

Incremental backup type—Backs up all 
selected files that have changed since the most recent All Selected Files or 
Incremental backup.

See “Backup Types” on page 70 for more information about these backup 
types.

Unattended operation

Check Unattended operation to run unattended backup jobs. This option 
enables the program to bypass all prompts during a backup operation.
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Exclude Files Tab
Use the Exclude Files tab to exclude certain file types from your Backup Job. 
File exclusions are made based on registered type or custom type.

NOTE: Excluded file types are marked in the selection panes with a red 
X.

To exclude files by registered type:

1. Click the Exclude Files tab in the Backup Job Options dialog box.

The Exclude Files tab appears.

2. Click Add. 

The Exclude files from backup dialog box 
appears. 

3. Click Registered type.

4. Select the file type you want to exclude in 
the Registered type list. 

5. Click OK. 

Your exclusion appears in the Do not back 
up files of these types list box. To exclude additional registered file types, 
repeat steps 2 through 5.

To exclude files by custom type:

1. Click the Exclude Files tab in the Backup Job Options dialog box.

The Exclude Files tab appears.

2. Click Add. 

The Exclude files from backup dialog box appears. 

3. Click Custom type.

4. Type a three letter file extension in the Custom type text box. 

For example, type bat to exclude all your batch files.

5. Click OK.

Your exclusion appears in the Do not back up files of these types list box.

To exclude additional file types, repeat steps 2 through 5. 
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To remove a file type from the Do not back up files of these types list:

1. Select the file type you want to remove from the list. 

2. Click Remove.

Advanced Tab

Use the Advanced tab to specify whether or not the Windows 95 Registry and 
the Netware Bindery files are backed up.

• Back up Windows 95 Registry(Recommended)—The Registry is 
automatically selected for backup when your local drive is selected.

• Back up Netware Bindery...—Backs up the Netware Bindery when a 
Netware system volume is selected for back up. Backup Exec will back up 
NetWare 3.11-3.12 server bindery, and NetWare file and directory 
attributes from NetWare server volumes, including trustee information. 

NOTE: If you don’t have the Novell 32-bit NetWare client installed, the 
Back up Netware Bindery... option will not be availalbe.

To set the Advanced Options:

1. Click Options on the Backup windows.

The Backup Job Options dialog box appears.

2. Click the Advanced tab in the Backup Job Options dialog box.

The Advanced tab appears.

3. Check the options you want.

Click OK.
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Scheduling a Backup Job
Backup Exec provides an easy and effective way to schedule your backup jobs. 
Scheduling your backup jobs can save you time and ensure that your files are 
backed up regularly. 

You can choose to run your job once, daily, weekly, or monthly. Once you 
schedule your backup job, and save the settings, your backup job runs automat-
ically at the set times. If necessary, you can turn your backup job schedules on 
or off. 

If you have scheduled jobs pending when you exit Backup Exec, a dialog box 
displays and asks if you want to minimize the application to allow scheduled 
jobs to run. Select Yes and the program displays a small icon on the Windows 
95 taskbar. This icon enables scheduled jobs to run. Right-click the icon to 
open or close Backup Exec.

To schedule a backup job:

1. Click Schedule on the Backup window.

The Schedule Backup Job 
dialog box appears. The 
name of the selected 
Backup Job is displayed 
on the title bar.

2. Select Once, Daily, 
Weekly, or Monthly.

The program displays option settings that correspond to your selection. 
For example, if you select Weekly, the program prompts you to choose a 
time and the day of the week for your backup job. See “Setting 
Frequencies” on page 42 for additional information.

3. Choose your settings.

4. Click OK.

To edit a scheduled backup job:

1. Select the job you want to schedule in the Backup Job drop-down list box.

2. Click Schedule.

The schedule for this job appears.

3. Make your changes.
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4. Click OK.

Setting Frequencies
When you schedule a backup job, the settings that appear depend on the fre-
quency you choose:

• Once— Set the time and the date.

• Daily—Set the time. If you want to 
specify certain days of the week for 
your job to run, click Which Days, 
then check the days you want your 
job to run.

• Weekly—Set the time and the day 
of the week.

• Monthly—Set the time and the day 
of the month.
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Using Restore
This chapter explains how to use the Restore Wizard and the Restore window 
to restore files to your hard disk. Restore reads the selected backup sets and 
restores your files to a specified location (usually their original location). You 
can restore one file, several selected files, or all files from a backup job. You 
can also select individual versions of a file, specify the destination for the 
restored files, and set options.

Whether you are restoring your entire system, a single file, or a particular ver-
sion of a file, Backup Exec makes it simple to set up the restore process. You 
can use either the Restore Wizard or the Restore window to specify your 
restore.

Where to Look—Restore
For more help on restore topics, see:

• Creating an Emergency Recovery Diskette, page 43

• Emergency Restore, page 44

• One-Button Restore, page 45

• Restoring All Your Files, page 46

• Using the Restore Wizard, page 48

• The Restore Window, page 49

• Restoring Files with the Restore Window, page 54

• Restore Progress Window, page 55

Creating an Emergency Recovery Diskette
Backup Exec Emergency Restore enables you to rebuild the operating system 
and the latest All Selected Files backup without having to reinstall the operat-
ing system or the backup software.Your entire local drive can be restored using 
the Emergency Recovery Diskette.
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The first time Backup Exec launches, you are prompted to create an emergency 
recovery diskette. If you do not create an emergency recovery diskette at that 
time, you may do so later by choosing Emergency Diskette from the Tools 
menu.

To create an Emergency Recovery Diskette:

1. Select Recovery Diskette from the Tools menu.

2. If you have more than one device, your devices appear on the Tools menu 
under Emergency Diskette. Select the device you want to use to store your 
local drive and Registry files.

3. Insert the Emergency Diskette into drive a:.

4. If the diskette is not formatted, select Yes to format the disk.

A progress screen appears. A message displays when the Emergency 
Diskette is complete.

NOTE: If you are using a compressed drive for your Emergency 
Recovery diskette creation and restore process, you may not be able to 
restore all of the data.

If you are using a SCSI device for Emergency Restore, you must have DOS 
ASPI drivers.

Emergency Restore
The emergency restore process can be used to recover from hard disk failure. If 
you do not have an emergency recovery diskette, see Restoring All Your Files, 
page 46. If you created an emergency recovery diskette, follow the steps 
below. 

To use Emergency Restore:

1. Boot up your system with the Emergency Diskette.

2. The computer boots into DOS mode. Instructions appear on your screen, 
prompting you to start the media-based recovery process. Choose Yes to 
launch the Emergency Restore program. 

The instructions on your screen also help you partition and format the hard 
disk prior to restoring.

3. Follow the steps on your screen and insert the media containing the most 
recent All Selected Files backup of the drive you want to restore.
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The media is scanned, and you are presented with a list of sets on the 
media. 

4. Select the set you want to restore by using the arrow keys to highlight the 
set. After you’ve highlighted a set to restore, press Enter.

Backup Exec displays a list of drives backed up within a selected set. 

5. Select the drive you want to restore by using the arrow keys to highlight 
the drive, then press Enter.

A temporary catalog is rebuilt from the media. Everything in the selected 
volume is restored. A message displays when the restore is complete.

6. Remove the ER disk, then reboot your system. You may need to reboot 
several times if any hardware changes have occurred.

One-Button Restore
One-Button Restore launches a series of dialogues which help you perform a 
restore in just a few steps.

To run One-Button Restore:

1. Double-click the One-Button Restore icon in the Backup Exec program 
group. Or, click the Start menu, select Programs, select Backup Exec, and 
then click One-Button Restore. 

The One-Button Restore 
dialog box appears.

2. Select a device or Files or 
Folders in the drop-down list 
box. If you select Files or 
Folders, an edit box and 
browse button appear. See 
“Files or Folders Backup” on 
page 30 for more 
information.

A progress dialog appears, 
then the file selection panes appear.



3. Check the drives, folders, 
and files you want to restore.

4. Click Start to begin restoring 
your files. A message 
appears when the restore 
completes.

Restore Default Settings
Your restore will run with the following default settings:

• What to restore—Folder view. See “File Views” on page 52.

• Where to restore—Original Location. See “Where to Restore” on 
page 53.

• How to restore—Do not replace. See “How to Restore” on page 54.

Restoring All Your Files
This section explains how to quickly and easily restore all your files in the 
event of a hard disk failure. This procedure can also be used to transfer all your 
files to a new computer.

Before you can restore your files after a hard disk failure, you must first pre-
pare your hard disk and reinstall Windows 95. Then follow these steps:

1. Install and configure Backup Exec. See “Installing Backup Exec” on 
page 10.

2. Collect the media(s) containing your most recent All Selected Files and 
your New and Changed Files backups. The backup sets you’ll need to 
restore depends on your backup strategy.

If you performed:

All Selected Files only—restore only your most recent backup set.

All Selected Files and Differential New and Changed Files—restore 
your All Selected Files backup first, then restore the most recent 
Differential backup set.
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All Selected Files and Incremental New and Changed Files—restore 
your All Selected Files backup first, then restore each of the Incremental 
backups sets in order, starting with the oldest.

3. Restore the All Selected Files backup set. Make the following option 
selections on the Restore window:

What to Restore—Click Device view, then select each local drive and the 
Registry. 

Where to Restore—Choose Original Locations.

How to Restore—Choose Always replace.

4. If you backed up the Windows 95 registry, the Restore Registry dialog 
box appears.

CAUTION:  Restoring the Registry may cause serious problems if your 
hardware configuration has changed since you last backed up the Registry.

If your system’s hardware configuration and system settings have not 
changed since the last backup of the registry, select Restore hardware 
and system settings to the registry, then click OK.

The entire registry will be restored along with all selected local drives.

Or,

If your system’s hardware configuration has changed (if, for example, 
you’ve added a new drive or changed the IRQ settings on a card), deselect 
(uncheck) Restore hardware and system settings to the registry and 
continue with the operation, only those portions of the registry containing 
your software settings and configuration will be restored along with all 
selected local drives.

5. Restore any New and Changed Files backup sets using step 3 and 4.

Restoring Bindery Files
You can restore your bindery files, if you backed up files on your SYS volume 
or Novell Server and checked the Back up NetWare Bindery... option. See  
”Advanced Tab” on page 40 for more information on this option.

To restore your bindery files:

1. Click the Restore tab.

The Restore window appears.
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2. In the selection panes, select any file(s) on the SYS volume.

3. When prompted whether or not to restore the bindery, click Yes.

Using the Restore Wizard
The Restore Wizard guides you through the steps required to run a restore, 
using a series of windows to let you choose the options used to create your 
restore. After choosing an option, click Next to continue.

To create your restore using the Restore Wizard:

1. Click Restore Wizard in the Startup window and click OK or, click the 
Restore Wizard button on the toolbar or, select Restore Wizard from the 
Tools menu.

The Restore From window 
appears.

2. Choose the backup device to 
restore from.

3. You may select your files 
from the catalog stored on 
your hard disk or from the 
media in your drive. See 
“File Views” on page 59 for 
more information.

Click Next to continue.

The Restore selection pane 
window appears.

4. Click the check boxes next 
to the items you want to 
restore. For more 
information on file 
selection, see “Selection 
Panes” on page 19.

Click Next to continue.
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The Where to Restore window 
appears.

5. Choose a destination for your 
restored files.

6. If you choose to restore to 
another location, type a path 
into the text box or click 
Browse. 

7. Files are restored in their 
original folder structure unless 
you check Restore all files to a single folder. See “Where to Restore” on 
page 53.

Click Next to continue.

The How to Restore window 
appears.

8. Select an Overwrite option. 
See “How to Restore” on 
page 54.

9. Click Start.

The Restore Progress window 
appears.

See “Restore Progress 
Window” on page 55.

The Restore Window
This section first describes the Restore window. Step-by-step instructions for 
restoring your files begin on page 54.

The Restore window gives you quick access to all the restore options. The 
Restore window is composed of four sections.
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• Restore from—Select 
the backup device to 
restore from, or select 
Files or Folders if you 
backed up your files to a 
hard drive, network drive, 
or a floppy drive.

• What to restore—Select 
the files you want to 
restore.

• Where to restore to—
Select the location to 
restore your files to.

• How to restore—Select 
your overwrite option.

Restore From
The Restore from box lists all available backup devices to restore from. To 
change your restore from device, select another device in the drop-down 
list box. If you used the Files or Folders selection and backed your files up to a 
hard drive, a network drive, or a floppy disk, select Files or Folders in the drop-
down list box.

Restore Files or Folders

The Files or Folders option 
enables you to restore your files 
from a custom location, such as a 
hard disk, a network drive, or a floppy disk. 

When files are backed up to Files or Folders, Backup Exec uses a special nam-
ing convention to help organize the Files or Folders. Files or Folders appear 
with a .MTF extension. If you open a Files or Folders item in Explorer, Backup 
Exec automatically launches.

To restore your files from Files or Folders:

1. Select Files or Folders in the Restore from drop-down list box on the 
Restore window.

A text box and browse button appear below the drop-down list box. 

2. Type a path and filename in the text box. 
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Or,

Click Browse, select a folder in the list, then click OK. The folder appears 
in the text box.

File Find
The File Find option enables you to locate file(s) for restore. You can search by 
filename, location, and date backed up. Backup Exec lists all the backed up 
files that match your criteria. 

You may terminate the File Find operation at any time, by clicking the Close 
button.

To search for files with the File Find option:

1. Select the device that you used to back up your file(s).

2. Click the File Find button on the Toolbar or, select File Find from the Edit 
menu.

The File Find window appears. 

3. Enter a file name and path (if no path is entered, Backup Exec searches all 
paths). 

4. To search by date, click the Date Backed Up tab and enter a date or date 
range.

5. To start searching, click Find Now.

Backup Exec searches the catalog that corresponds to the selected device 
and displays a list of all files that match the search criteria. 

What to Restore
Select a file view and files to restore in the What to restore section. 

Catalog

Each time you make a backup, Backup Exec creates a backup catalog. This 
catalog contains information about the files and folders that were backed up 
and the Backup Job used. Backup Exec uses the information in the backup cat-
alog to restore or compare backed-up files.

After viewing the backup catalog, you may find items you no longer need to 
restore or compare. To remove these items from the backup catalog, use the 



Catalog Cleanup command located on the Tools menu. See “Catalog Cleanup” 
on page 65 for more information.

NOTE: If you are trying to convert a catalog from a previous version of 
your backup software that you used with several different devices for your 
backups, you may get a message indicating the catalog is empty. If this 
occurs, select Media view on the Restore window.

File Views
Backup Exec provides three different view options to help you select the files 
you need to restore.

• Folder view—view the catalog on the hard disk using the traditional file 
tree system.

• Media view—view the catalog by media.

• Device view—view the 
backup set(s) in the selected 
device. 

You may also limit your view to 
display the catalog listing for the 
selected device only.

To view files for a specific device:

1. Select the device you want to view in the Restore from drop-down list box 
on the Restore window.

2. Select Filter by device from the View menu.

The catalog listing for that device appears in the selection panes.

NOTE: To view a backup set that spans from one media to another, you 
must select Device view for all medium containing the backup set.

Restore Selection Panes
Backup Exec uses the same drive and file selection methods as the Windows 
95 Explorer. Drives and folders are selected in the All Folders pane and indi-
vidual files and folders are selected in the Contents pane. Select drives and 
files to restore by clicking the check box next to the item. For more informa-
tion, see “Selection Panes” on page 19.
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Multiple File Versions
If you back up the same set of files more than oncebackup device , you will be 
able to restore any of the versions you’ve backed up. 

Backup Exec normally restores the most 
recent file version. To restore an older ver-
sion, choose Version from the Edit menu or 
toolbar and use the File Version dialog box, 
which lists each available version’s size, 
media name, and date/time modified.

You can also open the File Version dialog if 
you right-click a file in the Restore selection 
pane, and then click Version.

Where to Restore
You’ll usually want to restore files to the same place from which you backed 
them up. However, if you want to restore your files to a different location, use 
the Where to restore box. The following selections are available:

• Original Location—All files and folders are restored to the same path 
from which they were backed up. This is the default setting.

• Alternate Location—All files and folders are restored using the original 
tree as backed up, but the root of the tree is set to the specified path.

• Single Directory—All files and folders are restored to a single folder, 
specified in the path text box.

To restore your files to an alternate location:

1. Select Alternate Location from the Where to restore list.

2. Type a path into the text box.

Or,

Click Browse, select a folder in the list, then click OK. The folder appears in 
the text box.

To restore your files to a single folder:

1. Select Single Directory from the Where to Restore drop-down list box.

2. Type a folder (directory) name into the text box.

Or,
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Click Browse, select a folder from the list, then click OK. The folder 
appears in the text box.

How to Restore
Restore options let you choose how to treat files in your backup set with the 
same name as those on your hard drive.

To set your restore options:

1. Click Options in the Restore window.

The Restore Options dialog box 
appears.

2. Choose a Restore option.

Do not replace—Never replace the 
files on the hard disk, even if the 
backed-up file is a more recent version 
than the file on the hard disk.

Replace older files—Replace only 
older files with the most recent file 
versions.

CAUTION:  Always replace—Always replaces the files on the disk. Always 
Replace always overwrites the files on your hard disk with the backed up files. 

3. Check Unattended operation and the program will bypass prompts during 
a restore.

4. Click OK.

Restoring Files with the Restore Window
To restore files using the Restore window: 

1. Click Blank Restore Job in the Startup window or, click the Restore tab 
from the Backup or Compare window.

The Restore window appears.

2. Select the backup device 
containing the files you 
wish to restore. If you 
backed your files up to a hard disk, network drive, or a floppy disk, select 
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Files or Folders. See ”Restore Files or Folders” on page 50 for more 
information.

3. To choose your files from your backup device instead of the catalog on 
your hard disk, select Device view. See “File Views” on page 52.

4. Click next to the drive and 
files you want to restore.

5. To change your restore 
location, select another 
location in the Where to 
restore box. See “Where to 
Restore” on page 53.

6. To change your restore options, click Options. See “How to Restore” on 
page 54.

7. Click Start.

Restore Progress Window
The Restore Progress window appears when 
you click Start and provides information 
about your restore. It is divided into three 
sections.

The top section lists the selected backup 
device and the name of your media. It also 
displays the current status of your restore.

The center section displays a progress bar 
and the time elapsed.

The bottom section lists the name of the file 
currently being restored, and the estimated 
number and size of the files restored.

You can cancel the restore at any time by clicking the Cancel button or press-
ing Esc.



When the restore is complete, the Cancel button changes to OK and a Report 
button is displayed below it. Click Report for a summary of your restore or 
click OK to continue.
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Using Compare
This chapter explains how to use the Compare window to read data from the 
backup set and compare it to the data on the hard disk. You can compare one 
file, selected files, or all files in the backup set.

Compare is a separate function designed to provide maximum data security. 
After you have created a backup set, you can go to the Compare window and 
verify that the information contained on the backup media is identical to the 
data on the hard disk and that it can be restored. 

NOTE: It is strongly recommended that you perform compares after your 
first few backups and after changing your system’s configuration. This 
will confirm Backup Exec is running properly on your computer.

TIP: Performing a compare at any time in the future lets you see how the 
files in the backup set differ from the files currently on the hard disk.

Where to Look—Compare
For more help on compare topics, see:

• The Compare Window, page 58

• Comparing Files with the Compare Window, page 60

• Compare Progress Window, page 61
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The Compare Window
The Compare window gives 
you quick access to all the com-
pare options. It consists of three 
main sections:

• Compare from—Select 
the backup device to 
compare from.

• What to compare—Select 
the files you want to 
compare.

• Where to compare—
Select the location to 
compare your files to.

Compare From
The Compare from drop-down list box lists all available backup devices to 
compare from. To change your compare from drive, select another drive in the 
drop-down list box.If you used the Files or Folders selection and backed your 
files up to a hard drive, a network drive, or a floppy disk, select Files or Folders 
in the drop-down list box.

Compare Files or Folders

The Files or Folders option 
enables you to compare your 
files from a custom location, 
such as a hard disk, a network 
drive, or a floppy disk.

When files are backed up to a Files or Folders, Backup Exec uses a special 
naming convention to help organize the Files or Folders. Files or Folders 
appear with a .MTF extension. If you open a Files or Folders item in Explorer, 
Backup Exec automatically launches.

To compare your files from a custom location:

1. Select Files or Folders in the Compare from drop-down list box on the 
Compare window.

A text box and browse button appear below the drop-down list box. 
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2. Type a path and filename in the text box.

Or,

Click Browse, select a folder in the list, then click OK. The folder appears 
in the text box.

What to Compare
Select the catalog location and files to compare in the What to compare 
section.

File Views
Backup Exec provides three dif-
ferent view options to help you 
select the files you want to com-
pare.

• Folder view—view the 
catalog on the hard disk 
using the traditional file tree system.

• Media view—view the catalog using a media view

• Device view—view the backup set(s) in the selected device.

You may also limit your view to display the catalog listing for the selected 
device only.

To view files for a specific device:

1. Select the device you want to view in the Compare from drop-down list 
box on the Compare window.

2. Select Filter by device from the View menu.

The catalog listing for that device appears in the selection panes.

Compare Selection Panes
Backup Exec uses the same drive and file selection methods as the Windows 
95 Explorer. Drives and folders are selected in the All Folders pane and indi-
vidual files and folders are selected in the Contents pane. Select drives and 
files to compare by clicking the check box next to the item. For more informa-
tion, see “Selection Panes” on page 19.
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Where to Compare
You’ll usually want to compare files to the same drive and directory as the one 
from which they were backed up. If their location has changed, however, the 
Where to compare box lets you specify where the original files are now 
located.

To compare your options to an alternate location:

1. Select Alternate Location from the Where to compare drop-down list box.

2. Type a path in the text box.

Or,

Click Browse, select a folder in the list, then click OK. The folder appears 
in the text box.

To compare your files to a single directory:

1. Select Single Directory from the Where to Compare drop-down list box.

2. Type a folder (directory) name into the text box.

Or,

Click Browse, select a folder from the list, then click OK. The folder appears in 
the text box.

To start comparing your files:

• Click Start. 

Comparing Files with the Compare Window
To compare your files:

1. Click the Compare tab in the Main Application window.

The Compare window appears.

2. Select the backup device  
containing the backup set 
you wish to compare in the 
Compare from drop-down 
list box. 
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3. Select the files you wish to 
compare. See “Selection 
Panes” on page 19 for more 
information.

4. Select a location in the 
Where to Compare drop-
down list box.

5. Click Start. The Compare Progress window appears.

Compare Progress Window
The Compare Progress window appears 
when you click Start and provides infor-
mation about your compare. It is divided 
into three sections. 

The top section lists the selected backup 
device and the name of your media. It 
also displays the current status of your 
compare.

The center section displays a progress bar 
and the time elapsed.

The bottom section lists the name of the 
file currently being compared, and the 
estimated number and size of the files compared.

You can cancel the compare at any time by clicking the Cancel button.

When the compare is complete, the OK and Report button replace the Cancel 
button. Click Report for a summary of your compare or click OK to continue.
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Tools
Backup Exec offers several tools to help you handle your medium, catalog, and 
reports. This chapter describes how to use Media Tools, Catalog Tools, Report 
Tools, and Preferences. 

Media Tools 
The following Media Tools commands are located on the Tools menu. 

NOTE: If you have more than one backup device  configured, each device 
will be listed and will have its own set of tools. Different drive types use 
different tool sets.

Identify 
This command displays the media’s contents. 

To identify a media:

1. Select Media from the Tools menu, then select Identify.

The Identify window appears. The device name and media name are 
displayed.

2. To view the backup sets on the media, click View media in the Identify 
Progress window.

3. Select OK to close the Identify window.

Format 
This command formats a QIC media. When a media is formatted, all data on 
the media is lost. Formatting can take several hours to complete, depending on 
the media type.

NOTE: SCSI medium use the Initialize media tool instead of the Format 
media tool.

To format a QIC media:

CAUTION:  Formatting destroys all data on the media.

1. Select Media from the Tools menu, then select Format.



If the media contains data, a message box appears asking you to confirm 
the operation.

2. Click Yes to confirm the operation or No to cancel.

3. Enter a new media name, then click OK.

If the drive supports multiple capacities, you are prompted to select either 
a high or low capacity format.

Erase
This command erases all files on a SCSI media, and positions the media to start 
recording.

To erase a SCSI media:

CAUTION:  Erasing destroys all data on the media.

1. Select Media from the Tools menu, then select Erase.

If the media contains data, a message box appears asking you to confirm 
the erase.

2. Click Yes to confirm the operation or No to cancel.

The Erase Progress window appears.

Initialize
This command erases a media and prepares it for use. 

To initialize a media:

CAUTION:  Initializing a media destroys all data on the media.

1. Select Media from the Tools Menu, then select Initialize.

If the media contains data, you are prompted to confirm the initialize.

2. Click Yes to confirm the operation or No to cancel.

If you are using a SCSI media, you may enter a new media name.

3. Click OK.

The Initialize Progress window appears.

Retension
This command winds and rewinds a media to remove any slack and evenly ten-
sion the media by performing a fast forward and rewind. 
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To retension a tape:

• Select Media from the Tools menu, then select Retension.

The Retension Progress window appears.

Rename
Use this command to rename your QIC media.

To rename a QIC media:

1. Select Media from the Tools menu, then select Rename.

A dialog appears displaying the media name for the inserted QIC media.

2. If you wish to rename your QIC media, type a name in the text box, then 
click OK.

Emergency Diskette
Use this command to create a recovery disk.

To create a recovery disk:

• Select Emergency Diskette from the Tools menu. See ”Creating an 
Emergency Recovery Diskette” on page 43 for additional instructions.

Report Tools
Report tools give you access to the backup log or report, which provides 
backup information and error messages. The following commands are avail-
able under the Report sub-menu.

• View—Launches Notepad with the log file loaded and displays the last 
five reports.

• Print—Launches Notepad and prints the log file.

TIP: Click Report on the Progress window to view the report for the 
current backup, compare, or restore operation.

Catalog Cleanup
The Catalog Cleanup tool helps you manage your catalog. Use this command 
to delete items from the backup catalog. This command displays the Catalog 
Cleanup dialog box. See “Catalog” on page 51 for more information.

NOTE: If you remove a file from the catalog, you must perform a “Media 
View” to restore or compare that file.
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To delete items from the backup catalog:

1. On the Restore or Compare window, select Catalog Cleanup from the 
Tools menu.

The Cleanup Catalog dialog box 
appears.

2. Select a device, media, or backup set in 
the Remove from catalog list box.

3. Click Remove.

Preferences
The Preferences dialog box lets you set the following options:

General

• Beep for messages—The program sounds an audible warning when it 
displays messages.

• Show startup screen on application startup—The startup screen 
(page 13) is displayed each time the program starts.

Backup

• Back up the Registry when backing up Windows (Recommended)—
The Registry is automatically selected for backup when the Windows 
folder is selected.

• Compute selection information before Backup, Restore, and Compare 
operations—The estimated number and size of files selected are 
displayed. Computing selection information also enables Backup Exec to 
display time estimates and file counts in the Progress windows.
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Backup Strategies
This chapter provides advice and assistance for setting up your own backup 
strategy, which is nothing more than a plan for protecting your data. 
Remember, though, that unless your data is backed up, it is not protected.

Where to Look—Backup Strategies
• Protecting Your Data, page 67.

• Developing a Backup Strategy, page 68.

Protecting Your Data
The main purpose of a backup program is to copy the files on a hard disk to 
another location in case of a hard disk failure. Backup Exec also lets you 
recover deleted files, return to older file versions, and transfer files from one 
computer to another. 

Protect Against Hard Disk Failure
A hard disk can fail at any moment, rendering all data inaccessible. A “crash” 
can be caused by mechanical failure, software failure, an electrical surge, fire, 
water, or even dust and smoke particles. Partial hard disk failures are not 
uncommon. Sectors of a disk can lose magnetic retentiveness, resulting in cor-
rupted or lost data. 

Statistics show that the information on your hard drive probably represents 
well over 3,000 hours of work. The data, and your investment of both time and 
effort, should be protected from loss. Backup Exec provides such protection. A 
properly backed up hard disk can be restored within minutes.

NOTE: For assistance in case of a hard disk failure, see “Restoring All 
Your Files” on page 46.

Protect Against Accidental Deletion
Almost everyone has looked for a file only to discover that it has been acciden-
tally deleted. 
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With a good backup routine, your data is protected from such mishaps. When 
files are backed up, they can be restored to your hard disk. Backup Exec has 
been designed so you can locate and restore files as you need them.

Access Older File Versions
You may need to save or go back to earlier versions of your files. For example, 
you may need to see an earlier version of a spreadsheet or word processing 
document.

With Backup Exec, maintaining different versions of the same files can be a 
simple procedure. If backups are performed regularly, different versions of 
files will be available for quick and easy restoration. For more information see 
“Multiple File Versions” on page 53.

Archive Files
It seems that there is never enough space on a hard disk. The urge to delete 
rarely used files is tempered by the possibility, however small, that these files 
may be needed again. 

Archiving can help. Archiving is the process of saving copies of selected files 
for future retrieval. Backing up data provides an automatic facility for 
archiving. After files are backed up onto a media, you can delete them from 
your hard disk. If they are ever needed again, they can be easily restored. 

Transfer Files
You may need to transfer a set of files to a new computer or to all the comput-
ers in your department. Or you may need to bring files home from work each 
day. Backup Exec lets you transfer files from one computer to another. You 
simply back up the desired files and then restore them to other computers.

You don’t have to worry about fitting your files on diskettes or what to do with 
very large files, because you can fit most large files on a single media car-
tridge. If you are transferring more files than will fit on one media cartridge, 
Backup Exec will prompt you to insert another media as needed.

Developing a Backup Strategy
Before you perform your first backup, you may want to develop a backup strat-
egy. A strategy ensures Backup Exec is set up to match your priorities.
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Consider the following as you begin:

• What files must be backed up?

• How much time can you spend backing up?

• How often should files be backed up?

• What is the capacity of the backup device available for backups?

• How important is it to automate backups?

• Will you be working alone or does your routine depend on others in your 
organization?

• How important or valuable is your data?

Once you’ve made these decisions, you can get started. These issues are 
addressed in this chapter.

What Should You Back Up?
There are as many approaches as there are Backup Exec users. Here are some 
considerations in backing up data files and program files.

• Data files

A common practice is to back up data files daily or weekly. However, if 
losing one day’s work is more than you can afford, consider backing up 
more often.

• Program files

You may want to back up your program files during each All Selected 
Files backup, every few months, or when you add or reconfigure a 
software package. 

TIP: Backing up program files saves you the time and trouble of 
reinstalling and reconfiguring them from the original program diskettes if 
a problem develops.

Whenever you perform a backup, you can back up one file, one folder, or a set 
of files or folders on one drive or multiple drives. You can make your file 
selections each time, or save your selections and reuse them.

Flexibility
You can back up all your drives, including network drives, at one time. Or, you 
can base your backup strategy on how frequently a set of files changes. Then 
you can make monthly, quarterly, or semiannual backups of files that seldom 
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change (program files), and daily or weekly backups of files that change fre-
quently (data files).

Organization
Further, you may want to make separate backups of different types of data 
files. It is easiest to do this if you keep related files grouped together in their 
own folders or give them the same file extension. For example, it is easy to 
make separate backups of spreadsheet, graphics, and word processing files if 
each type is contained in its own folder or has a unique file extension. 

However, if you work on projects that require spreadsheet, graphics, and word 
processing files, it is easiest to back up all the project-related files if you keep 
them in one folder. If you keep your files in separate folders, you can still cre-
ate a backup set of all the project files by selecting them from various folders. 
The backup set you create can also be used to archive files at the project’s 
completion.

Backup Types
Backup Exec offers three backup types:

• All Selected Files backup 

NOTE: An All Selected Files backup is called a Full backup in previous 
versions of Backup Exec.

• New and Changed Files backup (Differential)

• New and Changed Files backup (Incremental)

Use the All Selected Files and either the incremental or differential backup 
types on a regular basis to safeguard your data.

All Selected Files Backup
An All Selected Files backup creates a backup set containing all the files that 
you select. It can include all the files on your hard disk (a total backup) or can 
include any combination of drives, folders, and files you designate. 

NOTE: It is important to remember that Backup Exec backs up only the 
files and folders you select. Files that are not selected will not be backed 
up.

You can back up your data by making only All Selected Files backups, but this 
is inefficient. Instead, Backup Exec lets you save time by performing partial 
backups that include only files that have changed. 



Developing a Backup Strategy

Using Backup Exec 71

An All Selected Files backup copies all selected files. Incremental and differ-
ential backups look at that same set of files and copy only the files that are new 
or have been changed since the last full or incremental backup.

All selected files backs up every file regardless of the file’s archive bit status. 
When the backup is complete, the archive bits are turned off.

NOTE: If you only select individual files manually, new files will not be 
backed up during an incremental or differential backup. If you want new 
files to be included, make sure the drive or folder where the files are 
located is selected.

Differential Backup
This option backs up all the selected files that have changed since the last All 
Selected Files backup. Therefore, a differential backup may take a little longer 
to complete than an incremental backup. On the other hand, you have to keep 
only the last All Selected Files and the latest differential backup sets to restore 
files successfully, so this choice may result in less media space needed for the 
entire backup set.

The differential backup backs up all files that have the archive bit on. When the 
backup is complete, the archive bit(s) are left on. Each file backed up will be 
backed up again in the next differential or All selected files session.

Incremental Backup
An incremental backup backs up all selected files that have changed since the 
last All Selected Files or incremental backup. Because an incremental backup 
backs up only files that have changed, it is quick, and you’re fully protected 
against data loss. Incremental backups have the added advantage of providing 
quick access to intermediate versions of your files.

For example, you might do an All Selected Files backup on Friday and incre-
mental backups each business day. You will need to keep all the backup sets 
made from Friday to Thursday. If you do the All Selected Files backup on Fri-
day and have to restore on Wednesday, you’ll need the backup sets made on 
Friday, Monday, and Tuesday. 

Incremental backups back up files with the archive bit on. After the backup 
completes, the archive bit(s) are turned off. Files won’t be backed up in the 
next incremental backup unless they are modified and their archive bits are 
reset to on.
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Backup Cycles
For a backup system to remain effective over time, backups must be imple-
mented in regularly maintained cycles. A backup cycle begins when you per-
form an All Selected Files backup of a group of files and includes either the 
latest differential or all the incremental backups you subsequently perform. A 
new backup cycle begins when you perform the next All Selected Files backup 
of the same group of files. The backup cycle for a set of files may last a day, a 
week, a month or longer if you prefer.

Backup cycles for different groups of files may be of different durations, 
depending on the types of files and how you use them. Your backup software 
keeps track of all the backups you perform as part of a backup cycle, to help 
you easily restore any files you have backed up.

To set up a weekly backup cycle with an All Selected Files backup on Friday 
and incremental backups on Monday through Thursday, use the following pro-
cedure.

To create a weekly backup cycle:

1. Label your media. If your backup requires more than one media, label and 
number all the medium so you can recognize them easily.

2. Start your cycle on Friday. Insert your first media in the backup device 
and perform an All Selected Files backup. 

3. On Monday, reinsert the media you used for the All Selected Files backup 
and perform an incremental backup. The incremental backup 
automatically appends to the All Selected Files backup. The media now 
contains all files backed up with the All Selected Files backup plus all files 
that were subsequently created or changed.

4. On Tuesday through Thursday, perform incremental backups. Each 
subsequent incremental backup appends to the previous backup. If you 
need more than one media, you will be prompted to change medium. After 
your Thursday backup, you will have a complete rotation set.

5. On Friday, begin the cycle with a second set of medium.

Create two backup media sets and alternate between the sets so that the most 
recent set is maintained while overwriting the previous media set. Be sure to 
label your medium so that you maintain two separate sets. If you are using your 
backup software for the first time, back up all of your files immediately. After 
your files are safely backed up, you can use the Schedule Backup Job dialog 
box object to establish a regular backup cycle.
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Troubleshooting Tips
This chapter provides troubleshooting tips to solve the most common configu-
ration, compatibility, and other issues.

Where to Look—Troubleshooting
• Backup Device Configuration, page 73

• System and Software Lockups, page 78

• Common Error Messages, page 80

• Other Frequently Asked Questions, page 83

Backup Device Configuration
This section is designed to help you configure your system. You will find use-
ful troubleshooting tips that can help you solve most of the problems you may 
encounter. 

Backup Exec supports plug and play operation. However, if for some reason 
your backup device  is not automatically detected, this section provides 
instructions on manually configuring your drive or controller. Chances are you 
won’t need to manually configure either of them, but since you are working 
with a new operating system, we want to make sure you have all the informa-
tion you need to get up and running quickly.
See your device type below for specific steps.

QIC Backup Devices
NOTE: If you are using a high-speed controller card, first see “High 
Speed Controller Cards” on page 77.

Conflicts With Drivers from Other Backup Programs
Some driver files from other backup programs and Windows 3.1 applications 
may conflict with your backup software. Table 1 on page 74 lists the driver 
files, with their associated application, that may be causing a conflict. 
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As a troubleshooting step, disable any drivers on your system that are causing 
the conflict. 

CAUTION:  If you are running the applications associated with these driver 
files, do not remove them permanently.

To disable drivers that may be creating conflicts:

1. Make a copy of your SYSTEM.INI file (found in your Windows folder) 
and name the copy SYSTEMBKUP.INI. This provides an unmodified 
copy of your original file.

2. Click Run on the Start menu.

3. Type system.ini and click OK. The SYSTEM.INI file opens in Notepad.

4. In the [386Enh] section of your SYSTEM.INI file, type a semi-colon (;) at 
the beginning of the driver file lines listed below. The semi-colon disables 
the driver that may be causing a conflict.

5. Save the modified SYSTEM.INI file and restart your computer.

If you find that any of the programs listed below with a dagger (†) are causing 
the conflict, you should obtain the Windows 95 version of the software to elim-
inate the problem.

Table 1: Driver File Lines and Associate Applications

Driver File Line Application

device=cmswtape.386 Colorado Backup for Windows
device=cmsdtape.386 Colorado Backup for DOS
device=vfintd.386 Backup Exec, Conner Backup,

Iomega Backup, Norton Backup
device=cpbvxd.386 Central Point Backup
†device=symevnt.386 Symantec Norton Utilities
†device=adw30.386 After Dark Screen Savers
†device=awdos.386 PCanywhere for DOS
†device=vpcaw.386 PCanywhere for Windows
device=fastback.386 Fastback Backup
device=irw286.drv Irwin Eztape Backup
device=novabkp.386 Novastor Backup
device=virwt.386 Irwin EZtape Backup



Conflicts With Other Programs
If the problem persists:

1. Make a copy of your WIN.INI file (found in your Windows folder) and 
name the copy WINBKUP.INI. This provides an unmodified copy of your 
original file.

2. Click Run on the Start menu.

3. Type win.ini and click OK. The WIN.INI file opens in Notepad.

4. Type a semi-colon (;) at the beginning of the load= and run= lines, then 
save the file.

5. Restart your computer and run Backup Exec.

Conflicts With Other Device Drivers
If the problem continues try changing the file extension of any Backup Exec 
drivers that are not in use to .old.

To change the file extension of Backup Exec drivers that are not in use:

1. Open the Explorer, double-click Window, double-click System, then 
double-click Iosubsys.

The contents of the Iosubsys folder appear in the right pane.

2. Search for the files listed in Table 2, and change their file extensions to 
.old. For example, rename drvwppqt.vxd to drvwppqt.old

3. Launch Backup Exec.

Table 2: Drivers Not In Use

If you are using this device: Change these files:

QIC backup device connected to 
the floppy disk controller

drvwppqt.vxd
drvwcdb.vxd

QIC backup device connected to 
the Parallel Port

drwq117.vxd
drvwcdb.vxd

SCSI backup device drvwppqt.vxd
drvwq117.vxd
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SCSI Backup Devices
If your system cannot locate your SCSI backup device, disable any real-mode 
drivers loading in your CONFIG.SYS file. Follow the steps below:

1. Click Run on the Start menu.

2. Type sysedit.exe and click OK.

3. Click on the CONFIG.SYS window.

4. Type rem at the beginning of each line that contains a real-mode driver. 
For example, rem device=c:\aspi\aspi4dos.sys

5. Save the CONFIG.SYS file.

6. Restart your computer and run Backup Exec.

Parallel Port Backup Device
If your system cannot locate your Parallel Port device, you may have an IRQ 
conflict.

To check for IRQ conflicts:

1. Right-click the My Computer icon and select Properties.

2. Click the Device Manager tab in the System Properties window.

3. Computer is highlighted and appears at the top of the list. Click Properties.

4. Make sure your printer port drive is the only device with an IRQ setting of 
07. If another device has the same IRQ setting, change that device’s IRQ 
setting to avoid conflicts.

NOTE: Your printer port may not appear in this list. If it does not appear, 
change your printer port IRQ setting using the steps in the next section.

5. Restart your computer and rerun Backup Exec.

To change your printer port IRQ setting to 07:

1. Right-click the My Computer icon and select Properties.

2. Click the Device Manager tab in the System Properties window.

3. Double-click Ports in the list box, select Printer Port (LPT1), then click 
Properties.

4. Click the Resources tab, then write down your current Input/Output Range 
settings.
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5. Uncheck Automatic Settings and select Basic Configuration 1 in the 
Setting based on drop-down list box.

Interrupt Request appears in the list box.

6. Highlight Interrupt Request and click Change Setting.

7. Select 07 for the new interrupt.

8. Click OK and verify that the Input/Output Range is at the setting you 
wrote down.

9. Click OK, then restart your computer.

If the problem persists:

• Remove any conflicting drivers or programs. See“QIC Backup Devices” 
on page 73.

• Some drives may be incompatible with enhanced parallel ports 
(ECP/EPP). Check with your computer hardware vendor to confirm the 
kind of parallel port you have and to learn how to change the setting from 
ECP or EPP to a compatible setting, such as bi-directional.

High Speed Controller Cards
If your system cannot locate your high-speed controller card, you must change 
your card’s settings. First remove your card, then reinstall and reconfigure 
your card with the new settings.

To remove your high-speed controller card:

1. Right-click the My Computer icon and select Properties.

2. Click the Device Manager tab in the System Properties window.

3. Double-click Tape Drive Controllers in the list box, select your high-
speed controller card, then click Remove.

4. Shut down your computer and ensure that the power is off.

5. Physically remove your high-speed controller card (see your hardware 
manual for instructions).

6. Turn the computer on and restart Windows 95.

To reconfigure and reinstall your high-speed controller card:

1. Select Settings on the Start menu, then click Control Panel, and then 
double-click the Add New Hardware icon.
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2. To begin installing your high-speed controller card, click Next.

3. The Add New Hardware Wizard asks if you want Windows to search for 
your new hardware. Click No, then click Next to continue.

4. Select Tape Drive Controllers from the Hardware types list, then click 
Next.

5. Choose the manufacturer and model of your controller card, then click 
Next.

6. Windows 95 displays the Resource Type and Settings. Print or write down 
these settings, which you will use to reconfigure your high-speed 
controller card.

7. Click Finish, then shut down your computer.

8. Change the settings on your card to match the settings provided by the 
Add New Hardware Wizard. See your hardware manual for information 
on changing your card’s settings.

9. Install your card, then restart your computer and Windows 95.

System and Software Lockups
If your system or software stops responding, there is often a conflict with out-
dated software drivers or with other software. This section will help you elimi-
nate those and other conflicts.

Backup Exec Locks Up During Installation
If you are using DriveSpace or Stacker, install Backup Exec on a non-com-
pressed volume. 

To determine which volume is non-compressed:

1. Click the Start button on the Task bar.

2. Click Programs, Accessories, System Tools, DriveSpace 3.

3. You should now see a list of the compressed volumes as well as the Host 
drive (the host drive is non-compressed). If you double-click on the host 
volume it will indicate how much space is available.

4. Ensure that you have at least 8Mb available on the host drive.
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5. Ensure that the host drive is not hidden. To unhide the host drive, click on 
the host drive and click the Properties button. Uncheck the “Hide this host 
drive” option.

6. Install Backup Exec to the host drive.

If Backup Exec still locks up after installation, boot Windows 95 in Safe Mode 
by holding down F8 during boot-up. Install Backup Exec while in Safe Mode. 
When the installation is complete, reboot the system in normal mode and then 
run Backup Exec. If this procedure does not resolve the problem, contact 
Seagate Software Technical Support (See “Contacting Technical Support” on 
page 83 ) and request replacement installation diskettes.

System Locks Immediately After Installation
If your system is locking up immediately after Backup Exec is installed, there 
may be conflicts between Backup Exec and other applications.

To disable other applications: 

1. Press the CTRL, ALT and DELETE key at the same time to display the 
Close Program dialog box. 

The only application that can be running is the Explorer. 

2. Close other applications by highlighting the desired application and 
clicking the End Task button.

If all applications have been disabled and Backup Exec is still not responding, 
rename (using an .OLD extension) the Bakcup Exec drivers not being used. 
See “To change the file extension of Backup Exec drivers that are not in use:” 
on page 75.

Backup Exec Locks Up While Displaying Selection 
Information Before a Backup
Files in your Recycle Bin may be conflicting with other files on your hard 
drive. Delete the files in your Recycle Bin before using Backup Exec.

To empty the Recycle Bin:

• Click the right mouse button on the Recycle Bin located on the Desktop, 
then select Empty Recycle Bin.
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To delete any protected files in the Norton Recycle Bin:

• Right click on the Norton Protected Recycle bin located on the desktop. 
Select Empty Norton Protected Files.

If the problem continues, files in TEMP and cache folders may be causing the 
backup software to appear locked up. Delete any on-line service TEMP folder 
files or Cache folder files. Most on-line and web browsers allow you to purge 
their disk cache (for example, Netscape, Microsoft Internet Browser, or 
AOLnet). 

To delete these temp files:

1. In NetScape 2.0, click Options, Network Preferences, Clear Disk Cache 
Now.

Or,

In Microsoft Internet Explorer, click View, Options, then Advanced tab. 
In the cache box, click Empty.

2. Launch Backup Exec and start the backup again.

Common Error Messages
This section lists some common backup device  errors.

“ASPI Manager Not Found” or “ASPI Manager Not 
Responding” 
1. Try the steps in  ”SCSI Backup Devices” on page 76.

2. Try the steps in ”QIC Backup Devices” on page 73.

3. Lower the rate at which data is transferred to the backup device from the 
SCSI BIOS to 5MB/sec. Refer to your hardware manual for complete 
instructions.

4. Ensure the SCSI backup device has a low SCSI ID (for example, a lower 
ID than a CD-ROM installed on the system).

5. Contact your hardware vendor for the latest BIOS or Firmware for your 
SCSI adapter card and/or backup device and get the latest Windows 95 
miniport driver for your SCSI controller.
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“Tape Controller Not Responding” Error During Backup, 
Compare, or Restore
If you have a parallel port backup device, see “Parallel Port Backup Device” 
on page 76.

If you have an internal QIC backup device that is attached to the floppy disk 
controller, use the Device Manager to verify that there are no extra backup 
device  hardware entries. 

To remove backup device  entries:

1. Right-click the My Computer icon and select the Properties command.

2. Click the Device Manager tab.

3. Locate the Tape Drive Controller section. If you find an entry in this 
section that has an “X” on the icon, remove it by selecting the item and 
clicking the Remove button. (You may not have a Tape Drive Controller 
section in the Device Manager).

4. Restart Windows 95.

If the problem continues and you are using a high speed controller (accelerator 
card), make sure that the settings on the card match those reported by the 
Device Manager. Refer to “High Speed Controller Cards” on page 77 for more 
information.

“DMA Conflict” During Backup or Compare
• First see “QIC Backup Devices” on page 73 for troubleshooting tips.

If the problem occurs after performing the steps in “QIC Backup Device,” fol-
low the steps below.

1. Go to Device Manager and double-click the backup device item. 

2. Select the backup device and click Properties. 

3. Select the Settings tab and disable “high speed burst mode,” “concurrent 
video update,” and “concurrent hard disk access.”

4. Reduce the transfer rate to its lowest setting (500 Kb/Sec).

If you still have a DMA conflict problem, use the lowest resolution setting 
available on your video card. If this fixes the problem, contact your video card 
or computer manufacturer for available driver updates for Windows 95.
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“Media Not Formatted or Unreadable”
If you are receiving a “media not formatted or unreadable by drive” error and 
are using an internal backup device, try these steps:

1. Right-click the My Computer icon and select Properties.

2. Click the Device Manager tab in the System Properties window.

3. Expand tapr drives and double-click your internal drive.

4. Click the Settings tab in the Properties window.

5. Uncheck the High speed burst transfers option and click OK.

6. Restart your computer.
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Technical Support
Many problems can be solved with the on-line help system or User's Guide. 
You can always press F1 to get help for the active window or dialog box. If 
you have a problem that cannot be solved using the on-line help or this User's 
Guide, collect the information described in “Preparing for Technical Support,” 
then refer to the telephone numbers listed on your manual cover.

Contacting Technical Support
Preparing for Technical Support

Write down your exact problem. Include the following information:

• Name and version number of your program copy.

• The wording of any error messages from your backup software, DOS, 
Windows, or any other application involved in the problem.

• Your computer name and model.

• Names and models of any additional hardware (expanded memory boards, 
special video cards, tape drive controllers, etc.).

• Operating system and version number (including Windows).

• Can you consistently reproduce the problem you are having?

• Has this problem occurred previously? If it is new, did you change your 
system configuration recently?

When calling, follow these guidelines:

• Call from a phone next to your computer.

Please have your notes ready with the information described above, then 
contact the technical support number shown on the back cover of your user 
guide.
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